Configuring Fiery Color Settings to Optimize Print Quality
This white paper explores how color management works in application software and print workflows for specific market segments. It provides a brief introduction to color management functionality and value, along with general guidelines for configuring color settings on the Fiery® controller for specific workflows. The paper also has in-depth explanations and analyses of color settings for specific products in the Adobe® Creative Suite® and Microsoft® Office™ product lines, along with guidelines for achieving the best and most predictable color matching when printing from these applications. Finally, it reviews direct submission of prepared PDFs to the Fiery controller and defines best practices for PDF workflows.

**Fast Facts**

- Fiery controllers use true ICC color management to match colors from various applications and workflows.

- Users configure color management on the Fiery controller through Fiery Command WorkStation® and may set a variety of parameters at the controller or per job.

- Settings are easy to configure to guarantee consistent output every time from applications.

- For more complex workflows, an exploration of the software and settings used in the design process reveals the proper color settings for the Fiery controller.

- Some workflows may require different color settings for different inputs. This is easy to do with Fiery Hot Folders.
What is Color Management?

Color management is the process of gamut mapping with the goal of preserving color appearance from one device to another. In order to understand this, we need a few basic definitions. Even if you are an experienced practitioner of color management, please take a moment to read through this section to confirm your understanding of the terminology that will be used in the rest of the paper.

First we must understand the difference between device-dependent and device-independent color spaces.

Device-dependent spaces include RGB and CMYK. These color models “depend” on the device capturing, displaying or printing the color for how the colors will appear. For example, look at a row of televisions in an electronics store. Even though they are all receiving the same signal, and therefore the same RGB values, the same picture on each TV looks slightly different. So the RGB “recipe” delivers a different color appearance on different devices. CMYK devices also allow us to see an easy example of the problem device-dependent color spaces present when printing. The same CMYK combination that prints a certain way on one print engine or press can look completely different on another printer.

Device-independent color spaces are ones we measure with a spectrophotometer like the EFI™ ES-1000. These color spaces define the way a color appears to the human observer. The “recipe” they supply is in a device-independent color system like L*a*b* — which tells us what the color looks like visually, rather than how to print or display it.

The next definition to clarify is gamut. Gamut is the total range of colors available on a particular device expressed in a device-independent color space. Going back to the television example, if each monitor has the same RGB values sent to it, the displays will look different because each monitor has a slightly different gamut. The way we can describe the appearance – and thus accurately describe the gamut of a given device – is by measuring the L*a*b* color appearance for all possible colors on that particular device.

Now we can define color management in a more specific way. Color management is the process of gamut mapping so that the colors from one device match on a different device. We use ICC profiles to define the gamut for each device. These profiles contain an index of the L*a*b* appearance values that define the gamut and the corresponding device-dependent color values that tell us the “recipe” to match that color on a particular device. ICC profiles let us accomplish color management by mapping the colors from one device’s gamut to another through the L*a*b* color space.

ICC color management works by using two profiles: one to define the input gamut and a second to define the output device gamut for the color conversion. The input profile tells us the gamut that the colors are starting in and how we can expect them to appear. We use this profile to convert the device-dependent (RGB or CMYK) values in the input file to the L*a*b* values that tell us what the colors are expected to look like. The output profile defines the gamut of the output device and we use it to find the right CMYK “recipes” for the output device to reproduce the colors as we expect them to appear.

Bear in mind that color gamuts are always unique in size and shape for a certain device. If the input gamut is larger than the output gamut, some colors will be lost in the gamut conversion process. This problem, known as gamut compression, may occur with some CMYK input spaces — depending on the gamut of a particular print engine. Gamut compression always occurs with RGB input colors, since these are typically larger than the gamut of a CMYK printing system. Setting the rendering intent for the color-managed conversions specifies the preference for gamut compression. In general, the professional printing industry most commonly uses the relative colorimetric rendering intent.

Color Processing Workflow

The ICC color processing workflow for RGB and CMYK input is shown in Figure 1. As noted above, you will need two ICC profiles for any ICC color conversion — one for input and one for output. Figure 1 shows a total of three profiles since it shows input profiles for RGB and CMYK sources, as well as the output profile for the print engine. As we will see in our exploration of the Adobe Creative Suite, the Fiery controller needs to know which input profiles to use for RGB and CMYK inputs.
Before we proceed with our exploration of color workflows, this is a good point to talk about the processing of spot colors such as those in the PANTONE® system. The Fiery controller is PANTONE calibrated and uses official libraries supplied by PANTONE to accurately match spot colors. The Fiery controller recognizes a spot or “named” color in a file being processed, then refers to the spot color libraries to search for the exact name of the color, such as “PANTONE 242 C.” When the controller finds the name, the library provides a definition of the color in the device-independent L*a*b* space. The Fiery Spot-On™ system takes the L*a*b* value for the color and uses the Fiery output profile to convert the value to CMYK for the specific output device and paper combinations.

Choosing the Best Profiles for your Workflow

In the following sections, we will provide instructions on how to set up the Fiery controller for general color workflows, and for printing from the Adobe Creative Suite and Microsoft Office. A third section details how to set up the Fiery controller for expert color environments that require you to import or export ICC profiles. In all cases, the profiles and settings we recommend will give excellent color results. If instructions in the earlier sections of this paper give you satisfactory color output, you can skip the rest of the sections.

The settings presented here are designed to preserve black-only pages that may be grayscale, CMYK using black values only or RGB page objects with equal values in red, green and blue. Fiery Gray features preserve black only, rather than color managing it to CMYK. This leads to sharper type and reduced click charges when printing black-only pages. This paper will identify the situations and workflows when you may need a special technique to maintain black preservation.

General Application Workflows

Application workflows fall into two general categories. The first is for most users who send files from Adobe Creative Suite and Microsoft Office applications. Users in this category typically calibrate the Fiery controller either off the glass, using Colorcal, or by using the ES-1000 spectrophotometer. The second category is professional printing firms that calibrate on a frequent basis with an ES-1000, create custom ICC profiles using EFI Color Profiler Suite (CPS) and track color quality using measurements with CPS Verifier Assistant. We will cover general workflows first. For users with critical color-matching requirements, including matching to a standard such as GRACoL or FOGRA, please be sure to read Section 3, Advanced Application Workflows.
Section 1—Basic Color Setup
Setting or Determining Preferred ICC Profiles in Adobe Create Suite

Launch Photoshop, and then select Color Settings from the Edit menu. Make note of the profiles you see for RGB and CMYK working spaces. Then quit Photoshop. You may set these ICC profiles as the inputs for the Fiery controller after first exploring other applications in the workflow.

Launch Adobe Illustrator and look at Color Settings under the Edit menu. Check to see if these color settings match what you saw in Photoshop. Next launch InDesign and look at its color settings in the Edit menu. Compare those as well. If all the applications used in the workflow have the same RGB and CMYK working spaces, then these are the input profiles to specify on the Fiery controller. Simply set these profiles as the input profiles on the Fiery controller as shown in Figure 2. Remember that you configure Fiery controller defaults from the Device Center section of Fiery Command WorkStation® on the Color Setup tab. Changing settings in Job Properties for a job in the Job Center will change the color settings only for that job.

This quick approach works if all the Creative Suite applications already use the same profiles and if you don’t need to print accurate color from Microsoft Office applications.

A better procedure to get all of the profiles to match throughout the Creative Suite is to use Adobe Bridge as described below.

Microsoft Office applications have no color settings and always work in sRGB. Therefore, the best general setting for a mixed Creative Suite and Office print workflow is to set Adobe applications to also use sRGB, and then set that as the Fiery RGB input profile.

If sRGB is not acceptable for Creative Suite users, you may need to create separate print workflows for Creative Suite and for Office. See Section 3, Advanced Application Workflows below for instructions on setting up for Adobe Creative Suite in professional color environments.

If you need both an advanced Creative Suite workflow and a workflow for printing from Office applications, consider using Fiery Virtual Printers to create two print paths to the Fiery controller, one with high-end settings for Adobe Creative Suite, and a second matching sRGB for Office.
For many users, the easiest way to configure a single color workflow is to use the sRGB working space in Adobe Creative Suite, since this is the only color space Microsoft Office applications can use. This way, you can set the Fiery controller to also use the same default setting. The best practice is to synchronize the Creative Suite applications to use the same color settings; then configure the Fiery controller to expect these color spaces.

To do this, launch Adobe Bridge. Then select Creative Suite Color Settings from the Edit menu. Choose the preset “North America General Purpose 2” for the U.S., “Europe General Purpose 2,” or “Japan General Purpose 2”—depending on where you are. See Figure 3.

Click the Apply button to synchronize these settings in all Creative Suite applications. Quit Adobe Bridge. Launch Photoshop and go to the color settings to confirm that the applications are now synchronized. See Figure 4.

Configuring Fiery Controller for General-Purpose Color Settings

Launch Fiery Command WorkStation and connect to the Fiery controller. Go to Device Center and click on the Color Setup tab. Depending on the Fiery system version, this tab may look slightly different. See Figure 5.
Now set the CMYK/Grayscale input profile at the upper left to the CMYK working space you synchronized and confirmed earlier in Photoshop. These could be SWOP-Coated (or SWOP2006 Coated 3, depending which is available on the Fiery system), FOGRA27 or Japan Color 2001 coated/type1 — depending on the region. See Figure 6.

Next, set Full (Output GCR) in the CMYK section as shown in Figure 7.

For RGB, set sRGB as the Fiery input RGB profile. This will work for both Office and Creative Suite applications, with color settings synchronized as described above. See Figure 8.

Set the Rendering intent to Relative Colorimetric for the most precise, natural color. See Figure 9.

Optional: if you want vivid (but less natural) color for Office applications and business graphics, choose Presentation instead of Relative Colorimetric, as shown in Figure 10.
Turn Spot Color Matching on as shown in Figure 11. This will enable the Fiery controller to use named color libraries such as PANTONE to color manage device-independent spot color definitions through the current output profile, for the most precise spot color matching.

For gray, set CMYK to Text/Graphics/Images and RGB to Text/Graphics. These settings are best to preserve black-only pages so they are not charged as color clicks. See Figure 12.

Application Print Settings

Photoshop CS5. Use the color management setting Printer Manages Colors when printing from Photoshop. See Figure 13.
Illustrator CS5. In the Illustrator print dialog, set: Let PostScript Printer Determine Colors, Relative Colorimetric and Preserve CMYK Numbers, as shown in Figure 14.

![Figure 14](image)

InDesign CS5. As with Illustrator, set: Let PostScript Printer Determine Colors and check Preserve CMYK Numbers. See Figure 15.

![Figure 15](image)

Printing from Microsoft Office Applications. You do not need special color settings when printing from Office. The applications will send colors in the sRGB color space already set on the Fiery controller so that colors will print correctly.

Adobe Acrobat Pro 9. PDF files are most likely to have a variety of color spaces included in them, some with ICC profiles embedded. The best practice is to import PDF files into Fiery Command WorkStation for printing, rather than printing from Acrobat. See “Sending PDF Files Directly” below. If you require an Acrobat print workflow, configure Acrobat by clicking on Advanced from the Print Dialog and setting color management to Same as Source. See Figure 16.

![Figure 16](image)

Sending PDF Files Directly. Importing PDF files into Fiery Command WorkStation or dragging and dropping them into Command WorkStation is the most efficient method of printing them to the Fiery controller. Since PDFs can have multiple color definitions in them, the best practice is to set the Fiery controller to honor embedded profiles, at least for RGB inputs. Setting this for CMYK inputs will cause black-only printing problems. See the next section for details. On older Fiery systems, set the system to use embedded profiles for RGB by setting None as the RGB input profile. For System 9 R2 and newer, use the checkbox in Expert Color Settings. Specify the same default RGB as shown above for your workflow. This setting will use the default profile specified for data without an embedded profile, and also respect embedded profiles if present for PDF files. See Figure 17.
Special Techniques for Black-Only Printing

Black-only printing will fail in certain cases, such as when sending black-only CMYK from Photoshop with Let Printer Determine Colors set. In such cases, consider converting to grayscale for black-only printing to save on click costs. If you must send the files as CMYK, choose Photoshop Manages Colors in the Photoshop print dialog, then set the Printer Profile to match the Document Profile as shown in Figure 18. In some workflows you will not be able to maintain black-only printing without additional special techniques. Post questions or advice on these topics to the Fiery Color Forum at http://fieryforums.efi.com/forumdisplay.php/127-Fiery-Color-and-Imaging-Topics.

![Figure 17](image17.png)

![Figure 18](image18.png)
Section 3—Advanced Application Workflows

Professional print organizations may need to do critical color matching to a standard such as GRACoL, SWOP or FOGRA39. This section will explain how to import and export ICC profiles from the Fiery controller to enable exact matching of color space definitions from design applications. It will also show a technique to soft-proof output from Fiery Driven™ engines in Adobe Creative Suite applications. It is important to note that this section is specific to the Creative Suite programs, and you should use the procedure described earlier in the paper for best results when printing Creative Suite and Microsoft Office applications in a single print workflow.

Before you proceed with the recommendations in this section, be aware that top-quality digital output requires regular calibration and custom ICC profile generation. For professional color results, you must perform calibration using an ES-1000 spectrophotometer. Custom ICC profiles for the Fiery controller give the best precision for your individual print system. You create ICC profiles with Color Profiler Suite 3.0, an available Fiery option. Color Profiler Suite takes the guesswork out of ICC profile creation for printers and monitors, allows iterating device link profiles for maximum precision and provides tools for testing color quality in digital workflows.

The first step is to build a custom Adobe color settings file (.csf) so that all the Creative Suite applications will use the same color profiles. You can do this by launching Photoshop and going to Color Settings from the Edit menu. For RGB, set AdobeRGB (1998), unless you have standardized on another RGB working space for the workflow. For CMYK, use the newest version of the local regional standard such as FOGRA, SWOP2006 or GRACoL. Or choose a CMYK reference you have confirmed to be within the gamut of the print system. You can identify such an input space using Color Profiler Suite Profile Inspector to compare a Fiery output profile print system with several reference press profiles. Choose a reference that is slightly smaller in gamut that the Fiery profile for extremely precise results. After you make all the adjustments, save the Adobe .csf file, and give it a descriptive name as shown in Figure 19. For this example, we saved the .csf file with the name “FieryPro.”

![Figure 19](image1.png)

Optionally, you may enter a description to explain what profiles you used, as shown in Figure 20.

![Figure 20](image2.png)
Load the new color profile presets. Open Adobe Bridge, select Color Settings from the Edit menu and select your preset. See Figure 21. Click Apply to synchronize the Creative Suite color applications.

To see that the new profile has been applied, launch Photoshop again and check the color settings from the Edit menu. This is now the new standard color profile the Creative Suite applications will use.

The last step is to configure the Fiery Color Settings to match your working spaces exactly. Launch Fiery Command WorkStation and connect to the Fiery controller. Click on the Device Center tab, Color Setup and then Color Management. See Figure 22.

Select the input profiles that match the working spaces synchronized in Adobe Creative Suite. Set Full (Output GCR) and select Relative Colorimetric for the RGB rendering intent. Turn on Spot Color Matching so the controller will use the spot color values instead of transforming them into CMYK values. Select Gray Text/Graphics for RGB and Text/Graphics/Images for CMYK to print gray using black-only.

**Loading Custom Profiles on Fiery Controllers**

In some cases, the profiles being used in Photoshop may not be the same as the profiles on the Fiery controller. One example of this is if the USWebCoatedSWOP profile is being used in Creative Suite with a newer Fiery controller that has the SWOP2006_Coated3 profile installed from the factory. In these cases, you may import the profile you are using for the working space definition in Creative Suite onto the Fiery controller so it is available in Color Setup. Another example is if you are using a custom press profile for a conventional press and need to match Fiery color output to that press.

For the SWOP example, navigate to Library/ColorSync/Profiles on Mac or `C:\WINDOWS\system32\spool\drivers\color` on Windows. Copy the profile you wish to load on the Fiery controller to your desktop.
To import your color profile, click on Device Center in Fiery Command WorkStation, select the Resources tab, Profiles, Import. Locate the color profile on your desktop and click on Import. Choose CMYK Source and Simulation as the type. Then select the profile and click import. See Figure 23. You can now set the imported profile as your CMYK source profile in Fiery Color Settings to exactly match the color space used in the design applications.

![Figure 23](image)

**Soft-Proofing**

If you want to soft-proof in Adobe applications, you will need to export the Fiery output profile and then load it onto the workstation where Creative Suite applications can access it. To export the output profile, go to the Device Center, Resources, Profiles. Go to Output Profiles and highlight the output profile in use for the print system and paper. This is the profile displayed in Color Setup for the server; if the system is set to Use Media Defined Profiles, identify the profile associated with the current media in use. You can see this with the output profiles in Device Center, Resources, Profiles, Output Profiles. Once you identify the output profile in use, click to highlight, then click export as shown in Figure 24.

![Figure 24](image)
Load the exported profile on your system by copying it to Library/ColorsSync/Profiles on Mac or by right-clicking the profile and selecting Install Profile on Windows. To configure soft-proofing in Photoshop, go to the View menu, Proof Setup, Custom. Select the profile exported from the Fiery controller, My Custom Coated Profile in this example. See Figure 25.

![Figure 25](image)

Be aware that soft-proofing relies on a calibrated and profiled display. You can profile displays using Color Profiler Suite. To achieve accurate color matches in soft-proofing workflows, it is also essential to have a high-quality display and color-calibrated light box for viewing prints.

Conclusions

Fiery color management is easy to configure. To preserve the appearance of colors in the input gamut on the printed output, you need two profiles to define the input and output gamuts for gamut mapping. This is the basic definition of color management.

The simplest way to configure the Fiery controller settings to match your color quality requirements is to see what profiles an application like Photoshop uses, then set these as the input profiles on the Fiery controller.

This gets more complex if you will also be printing Microsoft Office applications to the Fiery controller, since it means that the easiest path is to re-configure Adobe CS applications to also use the sRGB working space. If you choose this path, use the procedure that was presented in section 2 of this paper to first synchronize the color settings of Creative Suite, then set the matching profiles on the Fiery controller.

When printing PDF files by importing with Fiery Command WorkStation, many input profiles may be present, at least for RGB. In these cases, you will also want to set the additional color expert control Use Embedded Profiles (System 9 R2 and newer) or None for the RGB input profile on older Fiery systems. Section 3 of this paper defines an expert workflow to have Adobe CS use AdobeRGB and the most modern press standards.

There is no one right answer on how to configure all the applications to work together and give the best prints in all cases. If preserving black-only pages is a priority, test the settings recommended here with the application workflows to confirm predictable quality and black-only output.

This paper is intended to demystify color management and Fiery controller settings for all workflows. If you have suggestions, comments, questions, or corrections please post them on the Fiery Color Forums. Please make sure you reference the “Fiery Color Setup Whitepaper” in your post.

Want more information? Sign up for Fiery Color training at Fiery Global University.